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1 Background 
The database was designed and developed to house, analyse and present monitoring and 
evaluation for the Quang Ngai Rural Development Program (RUDEP).  Specifically, the 
database was designed to have four main components: 
• Participants – for information about participants at all scales relevant to the Program 

including community and institutional stakeholders at individual, household, 
commune, village and district scales.  

• Group work – for all information regarding workshops, meetings, and other 
groupings that formed as part of the Program such as PPP meetings, activity groups, 
credit groups and  capacity building groups. 

• Activities implemented – for all the detailed data surrounding the implementation of 
Program activities, as detailed in each annual operating plan. These data include for 
example, stock weights, prices and feed rations, or number of wells constructed, 
buildings planned or commune infrastructure completed. 

• Targets – the quantitative and qualitative targets established in each operating plan 
for all activities and indicators that will be reported against in RUDEP. These are 
reviewed at the beginning of each annual reporting cycle and automatically compared 
with actual results for reporting purposes. 

 

Further background information on the database and the M&E plan that it is designed to 
support, is given in the QRNDP Monitoring and Evaluation Plan (URS, February 2003). 
 
In March 2004, the M&E/Database Specialist was requested to visit the project site and 
provide advice on how to append data from the various district databases to a central 
database. A quick analysis revealed that given the current structure of the database, 
appending data from other datasets was not possible. A TOR, given below, was prepared 
to address this and other issues that were identified during this cursory analysis.  
• Create replicas. Convert the central database to a master file and provide replicas to 

the remote locations. 
• Re-engineer the interface and transfer the data tables to a separate MS Access file. 

Include simple procedures to prevent undesired modifications to the data or changes to 
the data structure. 

• Review existing forms and reports and rectify the problems identified. 
• Develop the pre-formatted reports required for project progress, and M&E reports. 
• Train the MEGO in the operation and maintenance of the system. 
• Provide email back-stopping support to the MEGO to ensure currency, integrity, 

relevance and accuracy. 
• Submit a written report to the Australian Team Leader and the Program Manager 

(emailed) in English at the completion of the mission. 
 

The in-country component of the TOR was conducted from April 30 to May 14, 2004.  
The in-Australia component was completed in June 2004. 
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2 System Analysis 
The first task undertaken was a more thorough analysis of the system. As no system 
documentation was available, this required analysing the M&E Plan to determine the key 
outputs that system must provide. It is also included analysing the processes and 
procedures that have been established to capture the data, process that data to provide 
information; and to disseminate that information to project managers and stakeholders. 
Some of the issues identified are summarised below. 
• The structure of the database does not allow the capture of time-series data.  As a 

result, the system cannot automatically generate the data required for the majority of 
the indicators given in Annex 2 of the M&E plan. 

• Built-in data integrity and data validation routines have not been adequate to ensure 
that key data fields are completed by the user.  For example, 20% of planning and 
activity group events are lacking dates. 2286 household records do not include the 
name of the household. 

• Duplicate Records. The system uses the household leader’s name to uniquely identify 
a household. The database currently contains 1473 records (11% of all household 
records) with the same household and hamlet name’ that have been entered more than 
once. It is likely that the majority of these records are duplicates i.e. the same 
household has been added to household list more than once. The same situation exists 
for the participants table where 10% of the records are probably duplicated. 

• The system is used to remotely capture data at several locations. The data files are 
regularly transferred (using a memory stick) to the project office. The system does not 
provide the facility to upload remote datasets to a central database. As result, project 
staff have been manually extracting data from the various district datasets and entering 
this into spreadsheets to prepare the required M&E reports. This approach is time 
consuming and vulnerable to data entry errors. The database cannot be appended with 
the current data structure. This is because unique record identifiers have not been 
provided for entities such as households, groups, group membership, problems and 
solutions. A system autonumber field has been used for these tables. When an 
autonumber field is appended, a new autonumber is generated and the link to related 
records is lost. 

• The interface (forms, queries, reports, macros etc.) and the data are currently stored in 
a single Access database. With this structure, if improvements are made to the 
interface (such as developing new reports) and then sent to the remote locations for 
installation, existing data at these locations will be lost. 

• No security is provided in the current system.  Any user is able to make modifications 
to the database, change picklists etc. 

• The system provides a limited number of pre-formatted reports and none of the 
reports/charts required to report on the indicators given in Annex 2 of the M&E plan. 
Staff are required to transfer the data to Excel to prepare the required reports.  This is 
particularly time consuming. 

• As only a Vietnamese interface is available, Advisers are alienated from the system 
and rely on translated reports provided by local staff. 

• Some aspects of the data structure are too rigid. For example, the interface has to be 
reprogrammed to allow for the collection of new indicators. 
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3 The New System 
The existing system has served as a very useful prototype.  There have been many 
valuable lessons learned and project staff are now in a better position to further refine the 
data management needs for project monitoring and evaluation. 
 
The key objective of this input is to design, construct and operationalise the new 
information system and the steps taken to achieve this are described in the following 
sections. 
 

3.1 Define Technical Requirements 
The following are the application design technical requirements for the MIS: 
1. Uses a relational data management system 
2. Must provide referential integrity 
3. Operate in Windows 9X/2000 environment 
4. Operate in a multi-user environment (Windows 9X/Windows NT Server)-support file 

sharing, record locking etc 
5. Must include user-level and group-level security 
6. Include data validation routines 
7. Users must be able to easily sort and query data and display the results 
8. Query results can be easily printed or exported to another application such as Excel 

and Word 
9. Must allow users to create advanced data queries 
10. Capable of creating charts and graphs which can easily be transferred to other 

applications – such as Excel or Word 
11. Additional data views, forms and reports can be added to the system without the 

assistance of a programmer 
12. Export tables, forms, queries and reports as HTML files 
 
The technology versions used for the development are as follows: 
• Microsoft Access 2000 (front end interface and data) 
• Microsoft Excel 2000 
• Microsoft Word 2000 
• Microsoft Chart 2000 
 

3.2 Define New Data Entities 
A new entity-relationship model was developed and the database restructured accordingly.  
The new data structure of the database is given in Annex 1. All data has been converted to 
the new structure. 
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3.3 Develop a Data Management Model 
The new RUDEP data management model is based on a replication/synchronisation 
model. Database replication is a technique used to support multiple users of an application 
where the users are not connected to a central network. Collectively, the copies of the 
database are called a replica set. One member of the replica set must be designated as the 
Design Master; any other copy is a replica.  The RUDEP Replica set is summarized in the 
table below. 

Table 1: Location of master and replica databases 

Location Replica type 

Project Management Office Design Master 
Binh Son PC Replica 
Duc Pho PC Replica 
Mo Duc PC Replica 
Nghia Hanh PC Replica 
Son Ha - Son Giang PC Replica 
Son Ha - Son Trung PC Replica 
Son Ha PC Replica 
Son Tinh PC Replica 
Tu Nghia PC Replica 

 

Synchronisation is the process whereby replicas within the replica set exchange data with 
each other.  As shown in the diagram below, the DDO’s memory stick plays an important 
role in the RUDEP replica set. It is used to synchronise between the District PC and the 
PMO server.   The key steps in the process are: 
• The DDO synchronises the database on the memory stick with the database on the 

District Office PC.  This should be done at least monthly. 
• The DDO then synchronises the database on the memory stick with the master on the 

Project Management Office server.  Any new data (or updates) on the memory stick 
will be transferred to the PMO server and vice-versa. 

• Upon return to the District Office, the DDO synchronises once again with the District 
Office PC.  This will ensure that the latest changes from the PMO and other districts 
are transferred to District Office database.  

 

Figure 1: MIS data model 

PMO Server DDO Memory Stick District Office PC
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3.4 Develop a new interface 
A common complaint about database applications is that they successfully capture and 
store data but do not promote the flow of useful and timely information back to the users. 
Users often find database applications too rigid – particularly if they are used to the 
flexibility of a spreadsheet application. A common complaint is that it is easy to get data 
into the system but difficult to get data out in the format that is required to produce 
useful information.  
 
Programmers often deal with this situation by trying to predict what outputs will be 
required and then providing numerous predefined report formats. In reality, it is 
impossible to predict all of the needs of all users and an interface needs to be able to deal 
with this uncertainty. Users need to be able to readily extract the data they require and 
easily convert it to an output e.g. a printed report, a graph, a spreadsheet or a word 
processing file. 
 

Figure 2: Key elements of the RUDEP MIS design 

HomeHome

Data ListsData Lists

Predefined 
reports 

Predefined 
reports 

Update FormUpdate Form

Printer & 
other 

applications

QueriesQueries

Predefined 
charts

Predefined 
charts

 

The interface designed for the RUDEP MIS attempts address the issues discussed above. 
This type of interface has been tested in a number of locations, with a high level of user 
involvement, and has been progressively improved over a number of years.  The key 
elements of this interface are shown in Figure 2 and described below. 
 

Home 
The Home page is a form that assists the user to navigate the system. It provides direct 
access to all data entry, queries, reports and charts  as shown in Figure 3. 
 
Data Lists 
A data list, is list of data that can be edited.  By displaying the data as a list, a user can 
easily locate the required record and call up an update form to edit the data.  The update 
form is also used to add new records.   
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Update forms 
The Update Form is accessed via the data list and is used for adding, modifying and 
deleting records.  All data validation procedures are included in the update form.  All 
update forms have the same “look and feel” to ensure consistency for the user. Only users 
with the appropriate authority are given access to the update form.   
 

Figure 3: RUDEP MIS home page 

 

 
Queries 
Queries are displayed in much the same way as in a spreadsheet Figure 4. Using queries, a 
user can: 
• Hide or display columns 
• Sort using any column 
• Freeze and unfreeze columns 
• Filter by selection 
• Filter using a form 
• Filter using a query 
• Customise the appearance of the screen (fonts, colours, grids etc.) 
• Be assured that they are not modifying data (data cannot be modified in Views) 
• Quickly find data 
• Sort and filter the view and output the result to a printer, Excel or Word 
 
Experience shows that with about one hour of “on the job” training, even new users 
quickly become competent in using the above features. 
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The advantages for the database developer/administrator are that queries are quick to 
program and because users are able to easily manipulate and print the data, fewer 
predefined reports are required. 

Figure 4: Example of a query 

 

 
Reports and Graphs 
The home page provides a list of predefined reports. When new reports are developed 
they are simply added to the list.  All reports can be previewed and either printed or 
exported to other locations. At list of available reports is given in Table 2. 
 

Table 2: Available reports 

Report Title 
Activity Group Annual Plan Summary 
Activity Group Summary Report 
Activity Group Details 
Commune Planning Meeting Details 
Commune Details and Indicators 
Contact Group Details 
DDO Monitoring Report 
DDO Targets 
District Details and Indicators 
GAS Results 
Hamlet Details 
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Report Title 
Household Profile and Indicators 
Problem Identification Summary 
Province Details and Indicators 
Summary of Proposed Activities 
Village Planning Group Details 
Village Details 

 
A charts module has been developed (Figure 4) and is used to access all the charts 
required for the indicators given in Annex 2 of the M&E plan. A list of available charts is 
given in Table 3. Charts can be copied to the clipboard and inserted into Word reports. 
 

Figure 5: Indicator charts 

 

 

Table 3: Available charts 

Chart Title 
Activity Group Participation 
Village Planning Group Participation 
Commune Planning Meeting Participation 
Capacity Building/Training Participation 
Households Participating in Repeat Planning Cycles 
Participation of Poor Households 
No. of Activity Group Plans Prepared and Funded 
No. of Activity Group Participants 
Demonstrations Implemented 
Roads Constructed 
Irrigation Constructed 
Markets Constructed 
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Chart Title 
Kindergartens Constructed 
Electricity Systems Constructed 
Wells Constructed 
Communal Water Supply Systems Constructed 
Women’s Health Models Implemented 
Activity Group Funding Breakdown 
Infrastructure Group Funding Breakdown 
Migration for Work - % Households 
Migration for Work – Duration 
VSCF Default Rates 
Households Using Institutional Credit 
Household Income 
Secondary Education Participation Rate 
Child Malnutrition Indicators 

 
Security 
Security has been included to ensure that: 
• Only users with appropriate access rights can access each database module. 
• Some users are only allowed to view data in each module. Others are able to view and 

update data. 
• Users can only modify records for their own district. 
• Only system administrators able to assign user access rights. 
 

Language 
The interface can be displayed in either English or Vietnamese. This includes all forms, 
queries and reports. 
 

4 Coding Systems and Indicators 

4.1 Problem Codes 
The RUDEP team revised the Problem Codes and the new codes (now known as Need 
Codes are given in Table 4. 

Table 4: Needs codes 

Need Codes 
1 Loans 
 1.1 Income generation   
 1.11 Livestock 
 1.12 Crops  
 1.13 Forestry/Tree Crops  
 1.14 Aquaculture  
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Need Codes 
 1.15 Non-farm  
 1.16 Other   
 
 1.2 Livelihoods   
 1.21 Health  
 1.22 Education  
 1.23 Disaster prevention/mitigation  
 1.24 Consumption  
 1.25 Other   
 
2 Training    
 2.1 Income generation   
 2.11 Livestock  
  2.111 Production 
  2.112 Veterinary/pest/disease 
  2.113 Information/Markets 
  2.114 Post-harvest 
 
 2.12 Crops  
  2.121 Production 
  2.122 Veterinary/pest/disease 
  2.123 Information/Markets 
  2.124 Post-harvest 
    
 2.13 Forestry/Tree Crops  
  2.131 Production 
  2.132 Veterinary/pest/disease 
  2.133 Information/Markets 
  2.134 Post-harvest 
    
 2.14 Aquaculture  
  2.141 Production 
  2.142 Veterinary/pest/disease 
  2.143 Information/Markets 
  2.144 Post-harvest 
    
 2.15 Non-farm  
  2.151 Production 
  2.152 Veterinary/pest/disease 
  2.153 Information/Markets 
  2.154 Post-harvest 
    
 2.16 Other  
  2.161 Production 
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Need Codes 
  2.162 Veterinary/pest/disease 
  2.163 Information/Markets 
  2.164 Post-harvest 
 
 2.2 Livelihoods   
 2.21 Health  
 2.22 Education  
 2.23 Disaster prevention/mitigation  
 2.24 Consumption  
 2.25 Other   
 
3 Provision (non-infrastructure)    
 3.1 Income Generation   
 3.11 Livestock  
 3.12 Crops  
 3.13 Forestry/Tree Crops  
 3.14 Aquaculture  
 3.15 Non-farm  
 3.16 Other   
 
 3.2 Livelihoods   
 3.21 Health  
 3.22 Education  
 3.23 Disaster prevention/mitigation  
 3.24 Consumption  
 3.25 Other   
 
4 Provision (Infrastructure)    
 4.1 Irrigation/drainage   
 4.2 Roads  
 4.3 Bridges   
 4.4 Water wells  
 4.5 Communal water system  
 4.6 Kindergartens/nurseries  
 4.7 Electricity  
 4.8 Markets  
 4.9 Other infrastructure  
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4.2 Activity Codes 
The RUDEP team prepared a list of Activity Codes that will be used to categorise Activity 
Groups. This will facilitate better reporting of problems and solutions being addressed by 
Activity Groups.  The new list is given in Table 5. 
 

Table 5: Activity codes 

Activity Codes 
1 Income Generation   
 1.1 Livestock  
 1.11 Pigs 
 1.12 Cattle 
 1.13 Goats 
 1.14 Chickens 
 1.14 Ducks 
 1.15 Buffaloes 
 1.16 Other  
 
 1.2 Crops  
 1.21 Rice 
 1.22 Maize 
 1.23 Cassava 
 1.24 Sugarcane 
 1.25 Peanuts 
 1.26 Grain legume 
 1.27 Vegetables 
 1.28 Other  
 
 1.3 Forestry/Tree Crops  
 1.31 Fruit trees 
 1.32 Industrial trees 
 1.33 Forestry 
 1.34 Other  
 
 1.4 Aquaculture  
 1.41 Rice/Fish 
 1.42 Fish pond 
 1.43 Marine Fishing 
 1.44 Other  
 
 1.5 Non-Farm  
 1.51 Agricultural processing (not post-harvest) 
 1.52 Non-agricultural production 
 1.53 Service industries 
 1.54 Other 



Quang Ngai Rural Development Program (RUDEP) - Phase 2 
Management Information Systems 13 

J:\JOBS\42443858\6000 BMS AND DELIVERABLES\6.1 REPORTS\6.1.3 FINAL REPORTS\CD3 FORMATTED REPORTS\FINAL WORD\DONE\58 RUDEP INFORMATION SYSTEMS ENG.DOC 

 
2. Livelihoods   
 2.1 Health  
 2.11 Child nutrition 
 2.12 Gynaecological disease 
 2.13 Digestive/common health problems 
 2.14 Malaria 
 2.15 Tuberculosis 
 2.16 Other 
 
 2.2 Education  
 2.21 Child education 
 2.22 Literacy/Basic Adult education 
 2.23 Vocational training 
 2.24 Other 
 
 2.3 Disaster prevention/mitigation  
 2.31 Floods 
 2.32 Drought 
 2.33 Storm  
 2.34 Fire 
 2.35 Other 
 
3. Infrastructure   
 3.1 Irrigation/drainage  
 3.2 Roads 
 3.3 Bridges  
 3.4 Water wells 
 3.5 Communal water system 
 3.6 Kindergartens/nurseries 
 3.7 Electricity 
 3.8 Markets 
 3.9 Other 

 

4.3 Activity Group Planning Codes 
A new coding system (Table 6) has been introduced to categorise the activities undertaken 
by Activity Groups as given in their action plans. This data is required to report on several 
of the indicators given in the M&E plan. 
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Table 6: Activity Group planning codes 

Item Unit 

1. Study tours No. 

2. Materials and Equipment VND 

3. Formal technical training No. of events 

4. Demonstration-Livestock No. 

5. Demonstration-Cropping No. 

6. Demonstration-Forestry No. 

7. Demonstration-Aquaculture No. 

8. Demonstration-Other No. 

9. Roads km 

10. Irrigation ha 

11. Markets No. 

12. Kindergartens No. 

13. Electricity No. of systems 

14. Wells No. 

15. Communal water supply system No. 

16. Women’s health model No. 

17. Other  

 

4.4 DDO Output Monitoring 
DDO output monitoring indicators a have been revised as shown in Table 7. Output 
monitoring reports have been included in the system and DDOs will no longer need to 
prepare a separate report. 
 

Table 7: DDO output monitoring indicators 

Indicator Unit 
1. No. of income generating groups No. of groups 
2. No of livelihood groups No. of groups 
3. No. of infrastructure groups No. of groups 
4. No. of VSCF groups No. of groups 
5. No. of income generating group annual plans No. of plans 
6. No. of livelihood group annual plans No. of plans 
7. No. of infrastructure group annual plans No. of plans 
8. No. of VSCF group plans No. of plans 
9. % of activity group members who are female % women 
10. % of activity group members who are from poor 
households 

% members 
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5 Next Steps 
The recommended next steps are as follows: 
1. RUDEP to complete interface translations. 
2. MEGO to create the district replicas from the Master database. Instructions are given 

in Annex 2. 
3. MEGO to install the new system in all districts and provide training. 
4. DDOs to update the database. Instructions are given in Annex 2. 
5. DDOs/MEGO to synchronise datasets monthly. Instructions are given in Annex 2. 
6. The next M&E/Database Specialists input should include: a review of system 

performance; rectifying and problems identified; addition of reports and charts 
identified by the PMU team; assisting the DDOs to identify information that can be 
fed back to stakeholders; training for MEGO and DDOS on using the system and 
interpreting M&E data; developing system documentation and user manual. 

 



 

 

Annex 1 

Data Entities



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: Commune Page: 1 

 Columns 
 Name Type Size 
 CommuneID Long Integer 4 
 CommuneCode Long Integer 4 
 CommuneName Text 50 
 DistrictID Long Integer 4 
 RUDEPOfficeID Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: ContactGroup Page: 2 

 Columns 
 Name Type Size 
 ContactGroupMemberID Long Integer 4 
 ProvinceID Long Integer 4 
 DistrictID Long Integer 4 
 CommuneID Long Integer 4 
 Name Text 50 
 Organisation Text 50 
 Phone Text 15 
 Email Text 50 
 Active Yes/No 1 
 GenderID Long Integer 4 
 RUDEPOfficeID Long Integer 4 
 Position Text 50 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: ContactType Page: 3 

 Columns 
 Name Type Size 
 ContactTypeID Long Integer 4 
 ContactTypeEN Text 50 
 ContactTypeVN Text 50 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: DDO Page: 4 

 Columns 
 Name Type Size 
 DDOID Long Integer 4 
 DDOName Text 50 
 Active Yes/No 1 
 RUDEPOfficeID Long Integer 4 
 DistrictID Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: DDOTarget Page: 5 

 Columns 
 Name Type Size 
 DDOID Long Integer 4 
 CommuneID Long Integer 4 
 DDOTargetTypeID Long Integer 4 
 DDOTargetYear Long Integer 4 
 Target Single 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: DDOTargetType Page: 6 

 Columns 
 Name Type Size 
 DDOTargetTypeID Long Integer 4 
 DDOTargetTypeVN Text 100 
 DDOTargetTypeEN Text 100 
 InUse Yes/No 1 
 UnitEN Text 50 
 UnitVN Text 50 
 DDOTargetTypeCode Single 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: District Page: 7 

 Columns 
 Name Type Size 
 DistrictID Long Integer 4 
 ProvinceID Long Integer 4 
 DistrictCode Long Integer 4 
 DistrictName Text 50 
 RUDEPOfficeID Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: GASGroup Page: 8 

 Columns 
 Name Type Size 
 GASGroupID Long Integer 4 
 GASGroupName Text 100 
 PCGLocationID Long Integer 4 
 CCGLocationID Long Integer 4 
 DCGLocationID Long Integer 4 
 AGLocationID Long Integer 4 
 GASDate Date/Time 8 
 GASLocationTypeID Byte 1 
 RUDEPOfficeID Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: GASIndicator Page: 9 

 Columns 
 Name Type Size 
 GASIndicatorID Long Integer 4 
 GasIndicatorNo Byte 1 
 GasIndicatorEN Text 100 
 GasIndicatorVN Text 100 
 InUse Yes/No 1 
 GasIndicatorShortTitleEN Text 100 
 GasIndicatorShortTitleVN Text 100 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: GASIndividual Page: 10 

 Columns 
 Name Type Size 
 GASIndividualID Long Integer 4 
 GasIndiviualCode Text 10 
 GenderID Long Integer 4 
 GASGroupID Long Integer 4 
 RUDEPOfficeID Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: GASIndividualResponse Page: 11 

 Columns 
 Name Type Size 
 GASIndividualID Long Integer 4 
 GasIndicatorID Long Integer 4 
 GasResponse Byte 1 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: GASLocationType Page: 12 

 Columns 
 Name Type Size 
 GASLocationTypeID Long Integer 4 
 GastLocationTypeEN Text 50 
 GASLocationTypeVN Text 50 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: GASResponseType Page: 13 

 Columns 
 Name Type Size 
 GASReponseTypeID Long Integer 4 
 GASResponseTypeNo Byte 1 
 GasResponseTypeEN Text 100 
 GasResponseTypeVN Text 100 
 GASIndicatorID Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: Gender Page: 14 

 Columns 
 Name Type Size 
 GenderID Long Integer 4 
 GenderEN Text 20 
 GenderVN Text 20 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: Group Page: 15 

 Columns 
 Name Type Size 
 GroupID Long Integer 4 
 GroupName Text 50 
 DateFormed Date/Time 8 
 Facilitator Text 70 
 RUDEPOfficeID Long Integer 4 
 Active Yes/No 1 
 GroupTypeID Long Integer 4 
 Notes Memo - 
 ProvinceID Long Integer 4 
 DistrictID Long Integer 4 
 CommuneID Long Integer 4 
 VillageID Long Integer 4 
 ProjectComponentID Long Integer 4 
 ProjectOutputID Long Integer 4 
 ContactTypeID Long Integer 4 
 ServiceProvider Text 50 
 RUDEPFunds Currency 8 
 GoVFunds Currency 8 
 OtherFunds Currency 8 
 ParticipantFunds Currency 8 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: GroupMembership Page: 16 

 Columns 
 Name Type Size 
 ParticipantID Long Integer 4 
 GroupID Long Integer 4 
 GroupYear Long Integer 4 
 RUDEPOfficeID Long Integer 4 
 GroupLeader Yes/No 1 

 Relationships 

 ParticipantGroupMembership 

 Participant GroupMembership 
 ParticipantID 1 ∞ ParticipantID 

 Attributes:  Enforced 
 RelationshipType:  One-To-Many 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: GroupPlan Page: 17 

 Columns 
 Name Type Size 
 GroupPlanID Long Integer 4 
 GroupID Long Integer 4 
 PlanYear Long Integer 4 
 RUDEPFunds Currency 8 
 GoVFunds Currency 8 
 OtherFunds Currency 8 
 ParticipantFunds Currency 8 
 RUDEPOfficeID Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: GroupPlanActivity Page: 18 

 Columns 
 Name Type Size 
 IndicatorID Long Integer 4 
 ActuallValue Double 8 
 PlannedValue Double 8 
 IndicatorYear Long Integer 4 
 ActivityDescription Text 100 
 GroupPlanID Long Integer 4 
 GroupID Long Integer 4 
 ItemNo Byte 1 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: GroupProblemTypeLink Page: 19 

 Columns 
 Name Type Size 
 GroupID Long Integer 4 
 ProblemTypeID Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: GroupSolutionTypeLink Page: 20 

 Columns 
 Name Type Size 
 GroupID Long Integer 4 
 SolutionTypeID Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: GroupType Page: 21 

 Columns 
 Name Type Size 
 GroupTypeID Long Integer 4 
 GroupTypeEN Text 50 
 GroupTypeVN Text 50 
 InUse Yes/No 1 
 ActivityGroup Yes/No 1 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: Hamlet Page: 22 

 Columns 
 Name Type Size 
 HamletID Long Integer 4 
 HamletCode Long Integer 4 
 HamletName Text 50 
 Zone Text 50 
 UTM_E Long Integer 4 
 UTM_N Long Integer 4 
 VillageID Long Integer 4 
 RUDEPOfficeID Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: Household Page: 23 

 Columns 
 Name Type Size 
 HouseHoldID Long Integer 4 
 HouseHoldName Text 50 
 HouseHoldCode Long Integer 4 
 Zone Text 50 
 UTM_E Long Integer 4 
 UTM_N Long Integer 4 
 HamletID Long Integer 4 
 RUDEPOfficeID Long Integer 4 
 NoOfMembers Byte 1 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: HouseHoldMembership Page: 24 

 Columns 
 Name Type Size 
 ParticipantID Long Integer 4 
 HouseHoldID Long Integer 4 
 RUDEPOfficeID Long Integer 4 
 DateJoined Date/Time 8 
 Active Yes/No 1 
 HouseHoldMemberTypeID Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: HouseHoldMemberType Page: 25 

 Columns 
 Name Type Size 
 HouseholdMemberTypeID Long Integer 4 
 HouseholdMemberTypeEN Text 50 
 HouseholdMemberTypeVN Text 50 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: Indicators Page: 26 

 Columns 
 Name Type Size 
 IndicatorID Long Integer 4 
 IndicatorCode Single 4 
 IndicatorDescriptionVN Text 50 
 IndicatorDescriptionEN Text 50 
 IndicatorUnitEN Text 50 
 IndicatorUnitVN Text 50 
 Province Yes/No 1 
 District Yes/No 1 
 Commune Yes/No 1 
 HouseHold Yes/No 1 
 Group Yes/No 1 
 InUse Yes/No 1 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: OutcomeIndicatorValue Page: 27 

 Columns 
 Name Type Size 
 IndicatorID Long Integer 4 
 MaleValue Double 8 
 FemaleValue Double 8 
 TotalValue Double 8 
 ProvinceID Long Integer 4 
 DistrictID Long Integer 4 
 CommuneID Long Integer 4 
 HouseHoldID Long Integer 4 
 IndicatorYear Long Integer 4 
 RUDEPOfficeID Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: Participant Page: 28 

 Columns 
 Name Type Size 
 ParticipantID Long Integer 4 
 OfficialCode Long Integer 4 
 ParticipantName Text 100 
 GenderID Long Integer 4 
 ParticipantOrganisation Text 50 
 ParticipantPosition Text 50 
 RUDEPOfficeID Long Integer 4 
 ProvinceID Long Integer 4 
 DistrictID Long Integer 4 
 CommuneID Long Integer 4 
 VillageID Long Integer 4 
 HamletID Long Integer 4 
 HouseHoldID Long Integer 4 
 DateAdded Date/Time 8 
 Active Yes/No 1 

 Relationships 

 ParticipantGroupMembership 

 Participant GroupMembership 
 ParticipantID 1 ∞ ParticipantID 

 Attributes:  Enforced 
 RelationshipType:  One-To-Many 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: PlanProblem Page: 29 

 Columns 
 Name Type Size 
 PlanProblemID Long Integer 4 
 Male Byte 1 
 Female Byte 1 
 Code Text 50 
 Problem Memo - 
 Rank Byte 1 
 GroupID Long Integer 4 
 ProblemTypeID Long Integer 4 
 PlanProblemYear Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: PlanSolution Page: 30 

 Columns 
 Name Type Size 
 PlanSolutionID Long Integer 4 
 Solution Memo - 
 GroupID Long Integer 4 
 SolutionTypeID Long Integer 4 
 ProblemTypeID Long Integer 4 
 PlanSolutionYear Long Integer 4 
 VillageID Long Integer 4 
 Problem Memo - 
 Rank Byte 1 
 ComponentID Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: ProblemType Page: 31 

 Columns 
 Name Type Size 
 ProblemTypeID Long Integer 4 
 ProblemTypeCode Single 4 
 ProblemTypeVN Text 50 
 ProblemTypeEN Text 50 
 InUse Yes/No 1 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: ProjectComponent Page: 32 

 Columns 
 Name Type Size 
 ComponentID Long Integer 4 
 ComponentNo Byte 1 
 ComponentEN Text 100 
 ComponentVN Text 100 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: ProjectOutput Page: 33 

 Columns 
 Name Type Size 
 OutputID Long Integer 4 
 OutputNo Single 4 
 OutputEN Text 100 
 OutputVN Text 100 
 ComponentID Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: Province Page: 34 

 Columns 
 Name Type Size 
 ProvinceID Long Integer 4 
 ProvinceCode Long Integer 4 
 ProvinceName Text 100 
 RUDEPOfficeID Long Integer 4 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: RUDEPOffice Page: 35 

 Columns 
 Name Type Size 
 RUDEPOfficeID Long Integer 4 
 RUDEPOffice Text 50 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: SolutionType Page: 36 

 Columns 
 Name Type Size 
 SolutionTypeID Long Integer 4 
 SolutionTypeCode Single 4 
 SolutionTypeVN Text 50 
 SolutionTypeEN Text 50 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: UserAccessRights Page: 37 

 Columns 
 Name Type Size 
 UserID Long Integer 4 
 Module Text 50 
 AccessToModule Yes/No 1 
 UpdateData Yes/No 1 
 DeleteData Yes/No 1 

 Relationships 

 UsersUserAccessRights 

 Users UserAccessRights 
 UserID 1 ∞ UserID 

 Attributes:  Enforced, Cascade Updates, Cascade Deletes 
 RelationshipType:  One-To-Many 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: Users Page: 38 

 Columns 
 Name Type Size 
 UserID Long Integer 4 
 UserName Text 50 
 Password Text 50 
 RUDEPOfficeID Long Integer 4 

 Relationships 

 UsersUserAccessRights 

 Users UserAccessRights 
 UserID 1 ∞ UserID 

 Attributes:  Enforced, Cascade Updates, Cascade Deletes 
 RelationshipType:  One-To-Many 



C:\Documents and Settings\Administrator\My Documents\My  Sunday, 4 July 2004 
Applications\RUDEP\ProjectMISData .mdb 
Table: Village Page: 39 

 Columns 
 Name Type Size 
 VillageID Long Integer 4 
 VillageCode Long Integer 4 
 VillageName Text 50 
 Zone Text 50 
 UTM_E Long Integer 4 
 UTM_N Long Integer 4 
 CommuneID Long Integer 4 
 RUDEPOfficeID Long Integer 4 
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1 Installing the RUDEP MIS 
Before installing the MIS, take a moment to review the system requirements listed below. 

1.1 System Requirements 

To use the MIS, your computer must have the following: 
• Intel Pentium processor at 133MHz or better; 
• At least 32 MB of RAM; and 
• 6.5 MB of available hard disk space. 

1.2 Install the MIS 

The ProjectMIS.mdb must be loaded on every PC where access to the MIS is required.  
The MIS datafile (ProjectMISDataXXX) should be installed in the same folder as the 
ProjectMIS file. 
 

1.2.1 To Install the MIS 
1. Create a folder on the hard drive called  “ProjectMIS”. 
2. Copy ProjectMIS.mdb and ProjectMISData to this folder. 
3. Create a shortcut to ProjectMIS on the Desktop. 
 

1.3 Starting the MIS for the First Time 
Call up the MIS by clicking on the ProjectMIS shortcut on the Desktop. 
1. Click the Setup button on the Login screen to display the Setup Window. 
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2. Click the Next button and then find the required data file in the Explorer window. 
3. Click the Next button and select the required District Office and language. 
4. Click the Finish button and the MIS Login screen will be displayed. 
5. Enter the User Name and Password and select OK (or press Enter). 
 

2 Setup Module 
The Setup Module can only be accessed by systems administrators and is used to manage 
user profiles and location data. 
 

2.1 Setting up User Accounts 
Login as a user with administrator privileges e.g. Admin 
1. In the MIS Home page, click Setup. 
2. In the Setup Module, click User Accounts. 
3. In the Current Users list, click the Add button on the toolbar. 
4. In the User form, enter a User Name, Password and District Office. 
5. In the Access Rights window, add the modules that the user will have access to and 

the data that they can modify (note: All users must be given access to the Home 
module). 

6. Click the Save and Close button. 
 

2.2 Changing Passwords 
All users can change their own password by doing the following: 
1. Select Change Password from the File Menu. 
2. Enter the current password and press Tab. 
3. Enter the new password and press Tab. 
4. Enter the new password again in the Verify field. 
5. Click the Save and Close button to save the record. 
 

3 Replicas 

3.1 Creating the Replicas 
Use Windows Explore to locate the ProjectMISDataMaster file.  Hold down the shift key 
and double-click on the filename. 
 
Note: holding the shift key down opens the database in design mode. 
1. From the Tools menu select Replication then Create Replica. 
2. Follow the instructions given on the screen and create the following replicas:  
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ProjectMISDataBinSon 
ProjectMISDataDucPho 
ProjectMISDataMoDuc 
ProjectMISDataNghiaHanh 
ProjectMISDataSonHaSonGiang 
ProjectMISDataSonHaSonTrung 
ProjectMISDataSonHa 
ProjectMISDataSonTinh 
ProjectMISDataTuNghia 

 
These are the datafiles that should be installed in each of the respective districts. 
 

3.2 Installing the Replicas 
To install the MIS in the district offices, follow the instructions given in section 1.2 and 
1.3. The datafile will need copied to the District Office computer as well as to the DDO’s 
memory stick. 
 

4 Synchronising Replicas 
Synchronisation is the process whereby replicas within the replica set exchange data with 
each other. As shown in the diagram below, the DDO’s memory stick plays an important 
role in the RUDEP replica set. It is used to synchronise between the District PC and the 
PMO server. The key steps in the process are: 
1. The DDO synchronises the database on the memory stick with the master on the 

Project Management Office server. Any new data (or updates) on the memory stick 
will be transferred to the PMO server and vice-versa. 

2. Upon return to the District Office, the DDO synchronises once again with the District 
Office PC. This will ensure that the latest changes from the PMO and other districts 
are transferred to District Office database.  

 
Note: The DDO synchronises the database on the memory stick with the database on the 
District Office PC. This should be done at least monthly. 

Figure 1: MIS Data Model 

PMO Server DDO Memory Stick District Office PC
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4.1 Synchronising and District Office Database with the 
Memory Stick 

1. Plug the memory stick into the District Office PC. 
2. Using My Computer or Windows Explorer click on the ProjectMISDataXXX (e.g. for 

Bin Sonh, the filename is ProjectMISDataBinSohn) on the Memory Stick. 
3. Select Synchronise Now from the Tools Menu.  You will be prompted to close the 

existing objects. Click Yes. 
4. The window shown below will open. Use the browse option to locate the datafile on 

the C Drive of the PC (e.g. for Bin Sonh, the filename is ProjectMISDataBinSohn) 
click OK. 

 

 
5. The Data Manager will synchronise the databases. Select Yes  to close and reopen the 

Data Manager. 
 

4.2 Synchronising the Memory Stick with the Project 
Management Office Database 

Plug the memory stick into the MEGO’s computer. 
1. Using My Computer or Windows Explorer click on the ProjectMISDataXXX (e.g. for 

Bin Sonh, the filename is ProjectMISDataBinSohn) on the Memory Stick. 
2. Select Synchronise Now from the Tools Menu.  You will be prompted to close the 

existing objects. Click Yes. 
3. Use the browse option to locate ProjectMISDataMaster on the C Drive of the 

MEGO’s PC and click OK. 
4. The Data Manager will synchronise the databases. Select Yes to close and reopen the 

Data Manager. 
5. Upon return to the District Office, the DDO should synchronise the memory stick   

with the District Office database again.  This will ensure that the latest changes from 
the PMO and other districts are transferred to District Office database. 

 

4.3 Viewing Different Data Files 
You can view different data files using the MIS.  You may sometimes wish to access the 
data contained in the transfer file on your memory stick on another computer. 
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4.3.1 To Change to a Different Data File 
1. Call up the MIS. 
2. Click Setup on the logon screen and select the new data file.  (Note: If you have 

already logged into the MIS you can simply select Data File from the File Menu). 
 

5 Priority Tasks for DDOs 
DDOs will need to check every record to ensure that: 
1. District data is up to date. This includes District Contact Group and indicators. 
2. Commune data is up to date. This includes District Contact Group and indicators. 
3. Village Planning Group data is up to date. This includes group details, membership, 

problems and solutions identified. 
4. Activity Group Data is up to date.  This includes all fields for activity details, need 

and activity codes, membership and action plans.  DDOs will also need to check that 
the Group Type is correct (e.g. Income Generation, Livelihood, Infrastructure) etc.  It 
was difficult to determine the group type in the old database and some may have been 
incorrectly coded. 

5. Credit Group Data is up to date. This includes all fields for credit group details, need 
and activity codes, membership and action plans. 

6. Contact/Training/Capacity group data is up to date. 
7. If a group is no longer active then the Group Status must be changed to “Inactive”. 
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Limitations 
URS Australia Pty Ltd (URS) has prepared this report in accordance with the usual care and thoroughness of 
the consulting profession for the use of the AusAID Quang Ngai Rural Development Program and only 
those third parties who have been authorised in writing by URS to rely on the report. It is based on generally 
accepted practices and standards at the time it was prepared. No other warranty, expressed or implied, is 
made as to the professional advice included in this report. It is prepared in accordance with the scope of 
work and for the purpose outlined in the Program Design Document. 
The methodology adopted and sources of information used by URS are outlined in this report. URS has 
made no independent verification of this information beyond the agreed scope of works and URS assumes 
no responsibility for any inaccuracies or omissions. No indications were found during our investigations that 
information contained in this report as provided to URS was false. 
This report was prepared during March 2003 and is based on the conditions encountered and information 
reviewed at the time of preparation. URS disclaims responsibility for any changes that may have occurred 
after this time. 
This report should be read in full. No responsibility is accepted for use of any part of this report in any other 
context or for any other purpose or by third parties. This report does not purport to give legal advice. Legal 
advice can only be given by qualified legal practitioners. 




